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INTRODUCTION
In this tutorial, you learn to create lathe custom tools, as well as explore the parameters that youmust understand
to create valid tools. Specifically, you learn about the following topics.

Tutorial Goals

l Drawing a lathe custom tool

l Configuring a lathe custom tool

l Using a lathe custom tool

WARNING: Screen colors in the tutorial pictures were modified to enhance image quality; they may not
match your Mastercam settings or the tutorial results. These color differences do not affect the lesson or
your results.

Estimated time to complete this tutorial: 2 hours

General Tutorial Requirements
All Mastercam2019 tutorials have the following general requirements:

l Youmust be comfortable using the Windows® operating system.

l The tutorials cannot be used withMastercamDemo/Home Learning Edition. The Demo/HLE file format
(emcam) is different fromMastercam (mcam), and basicMastercam functions, such as file conversions and post-
ing, are unavailable.

l Each lesson in the tutorial builds on the mastery of the preceding lesson's skills. We recommend that you com-
plete them in order.

l Additional filesmay accompany a tutorial. Unless the tutorial provides specific instructions on where to place
these files, store them in a folder that can be access from the Mastercam2019 workstation, either with the
tutorial or in any location that you prefer.

l Youwill need an internet connection to view videos that are referenced in the tutorials. All videos can be
found on our YouTube channel:
www.youtube.com/user/MastercamTechDocs

l All Mastercam tutorials require you to configure Mastercam to work in a default Metric or Inch configuration.
The tutorial provides instructions for loading the appropriate configuration file.

Mastercam Lathe Custom Tools Tutorial—Introduction

http://www.youtube.com/user/MastercamTechDocs
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CREATING A VERTICALLY ORIENTED TOOL
In this lesson, you create a vertically oriented tool that will be used in the machine’s upper turret to cut material on
the left spindle. To do this, youmust complete the following procedures:

l Draw the insert.

l Draw the holder.

l Set the tool’s properties.

l Test the tool with a toolpath.

Exercise 1: Drawing the Insert's Geometry
The first step in creating a custom tool is drawing its tool profile geometry. This geometry comprises two parts: the
insert and the holder. In this exercise, you draw the tool insert, shown below.

1. Start Mastercamusing your preferredmethod:

a. Double-click Mastercam's desktop icon.

OR

b. LaunchMastercam from the Windows Start menu.

2. Select the default metric configuration file:

a. Click the File tab.

b. Choose Configuration fromMastercam's Backstage View to open the System Configuration dialog
box.
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c. Choose ...\mcamxm.config <Metric> from the Current drop-down list.

d. ClickOK.

3. Click the Levels tab in the lower-left of Mastercam’s window.

The LevelsManager displays.

4. Change the Number field to 111.

Because tool geometry must be on its own level, with no other geometry, you should pick a level number
that you are unlikely to use in your part drawings.

5. SelectWireframe Color,More Colors from the Home tab.
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The Colors dialog box displays.

6. Change Current color to 14, and clickOK.

Youmust use different colors to draw the tool’s insert and holder. The recommended color for “insert up” is
14. For “insert down,” the recommended color is 138. For the holder, use color 116.

7. Choose Line Endpoints from theWireframe tab.

The Line Endpoints function panel displays.

8. Click in the graphics window, and draw a short line anywhere.
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9. In the function panel, set Length to 20, Angle to 45, and press [Enter].

10. Draw another line from the first line’s upper endpoint.

11. Set the line’s Length to 20, Angle to 90, and press [Enter].

12. Draw a line from the previous line’s endpoint, giving it a Length of 35 and an Angle of 0.

13. Draw a line from the previous line’s endpoint, giving it a Length of 25 and an Angle of 270.
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14. Draw a final line that closes the insert’s shape, and clickOK to exit the function panel.

Exercise 2: Completing the Insert’s Tip
1. Zoom in on the insert's tip.

2. Choose Fillet Entities from theWireframe tab.
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3. Select the tip’s two lines, set Radius to 0.8, and click the function panel’sOK button.

4. SelectMove to Origin from the Transform tab.

All of the geometry is selected automatically.

5. Select the fillet’s centerpoint.

The insert moves to the origin, with the tip arc’s centerpoint centered at 0,0.

6. Right-click in the graphics window, and select Fit.
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7. Right-click again, and select Clear Colors and then press [F9] to turn on the axes in the graphics window.

8. Zoom in on the origin, and notice how the insert’s tip is nowpositioned.

The insert’s position in the graphics windowdetermines how you define the tool’s parameters inMastercam.
For example, if you were to leave the insert’s position as it is in Step 8, when you set the tool’s parameters,
you would choose the compensation point shown below.
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Also, the tool’s center would be at 0,0.

The more common position for a vertically oriented tool is with the insert’s driving point fully in the upper-
right quadrant of the graphics window. In this case, you would set the compensation point and tool center as
shown in the following image.

In the remaining steps of this exercise, youmove the insert into the graphics window’s upper-right quadrant.

9. Select Translate from the Transform tab.

The Translate function panel displays.

10. Select the entire insert, and press [Enter].
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11. SetMethod toMove.

12. Set X and Y to 0.8, and clickOK.

The geometry moves to the selected position.

13. Zoom in on the origin to see that the insert’s tip is noworiented correctly.
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14. Fit the insert to the graphics window, and choose Clear Colors to restore the insert’s color to yellow.

15. Your completed lathe tool insert should look like the image below.

16. Save the file as CustomTool01_xxx, where xxx is your initials.

Exercise 3: Drawing the Holder
1. Press [F9] to hide the axes.

2. Change theWireframe Color to 116.

This is the recommended color for tool holders.
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3. Draw a line starting at the midpoint of the insert’s lower line, setting its Length to 45 and itsAngle to 111.

4. Draw a line from the top end of the previous line, setting its Length to 210 and itsAngle to 90.
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5. Draw a line from the top end of the previous line, setting its Length to 50 and itsAngle to 0.

6. Draw a line from the right end of the previous line, setting its length to 247 and its angle to 270.
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7. Draw a final line that closes the holder’s shape, and clickOK to exit the Line Endpoints function panel.

8. Save the file as CustomTool02_xxx, where xxx is your initials.

Note: The geometry used for custom tools is scaled to the current systemunits (inch or metric). Mastercam
assumes that the file with the tool geometry uses the same units selected on the Parameters tab of the
Define Tool dialog box.

Exercise 4: Setting the Orientation and Position
After you draw the tool’s geometry, youmust set the tool parameters that tell Mastercamhow to interpret and use
the tool geometry. These parameters include the following:

l Geometric Tool Orientation: Tells Mastercamhow to interpret the tool profile geometry, including cut and
plunge direction.

l Tool Geometry: Tells Mastercamwhether to read the geometry froma file or froma level in the current
part file.

l Tool Orientation in Turret: Defines how the tool ismounted in the turret, including cut and plunge dir-
ection.

Mastercam Lathe Custom Tools Tutorial—1: Creating a Vertically Oriented Tool



l Insert corner radius: Specifies the radius of the tool’s tip.

l Tool Center: Specifies the location of the tool tip’s centerpoint.

l Compensation: Determines the tool compensation to use whenMastercam calculates a toolpath.

In this exercise, you set the orientation and position of the tool.

1. Select Lathe, Default from theMachine tab.

Mastercam starts a newmachine group in ToolpathsManager.

2. Select Lathe Tool Manager from the Lathe Turning contextual tab.

The ToolManager dialog box displays.

3. Right-click in the upper box, and choose Create tool.

The Define Tool dialog box displays.

4. Select the Custom tool type.
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The dialog box automatically switches to the Geometry tab.

5. Ensure that for Geometric Tool Orientation In TOP Plane, orientation 1 is selected.

This is the orientation of the tool’s geometry as it is viewed in the Top plane. Note that choices 1 and 5 have
the same geometric orientation, but the cut and plunge directions are different. Orientation 5 is typically
used for horizontal tools.

6. Ensure that for Tool Orientation In Turret, orientation 1 is selected.

This is the orientation of the tool as it will be mounted in the turret. Note that, again, choices 1 and 5 have the
same geometric orientation, but the cut and plunge directions are different.

Note: If your machine has a B axis head, capable of rotating the tool for cutting at any angle, then the custom
toolmust be defined in the tool change orientation position.

7. Under Tool Geometry, select Level, and ensure that the level shown is 111. This is the level on which you
drew the tool geometry.
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Note: If you have your tool geometry in a separate file, you would choose the File option, and then use
Select to browse to the file containing the custom tool.

8. Click Select next to Corner Radius (mm).

The dialog boxminimizes so that you can access the graphics window.

9. Zoom in on the insert’s tip, and select the insert’s fillet.

Mastercam returns you to the Define Tool dialog box, with 0.8 entered for Corner Radius (mm).

10. Select Tool Center.

The dialog boxminimizes so that you can access the graphics window.
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11. Zoom in on the insert’s tip, and select the fillet arc’s centerpoint.

Mastercam returns you to the Define Tool dialog box, with X0.800 Z0.800 mm entered as the tool's center.

Exercise 5: Setting Tool Type and Compensation
1. Click the Tool Type tab, and ensure that General Turning is selected.

2. Click the Parameters tab, and ensure that the first Compensation option is selected.

This selection specifies that compensation for a toolpath is based on the sharp corner of the tip corner radius.
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Exercise 6: Setting Up the Tool
When you have specified the tool’s general parameters, youmust perform the tool setup. These settings define the
physical orientation of a tool and include, among others, the following:

l Mounting Position: Specifies whether the tool ismounted vertically or horizontally in the turret.

l Reverse tool: Specifies if you want the tool rotated in the turret 180 degrees from the default orientation.
For example, you would use this option when youwant to use a general turning tool for ID turning or a bor-
ing bar for OD machining.

l Turret: Tells Mastercamwhich turret the tool ismounted in.

l Default Active Spindle: Defines the spindle that Mastercam selects by default when you use this tool in an
operation.

l Spindle Rotation: Tells Mastercam the direction of spindle rotation.

l Tool Angle: Specifies the angle the tool is rotated for the toolpath.

l Home Position: Specifies the position to which the toolmoves for tool changes.

1. Select Setup Tool.

The Lathe Tool Setup dialog box displays.

2. Select the following:

a. Mounting Position to Vertical.

b. Turret to Top.

c. Default Active Spindle to Left.

d. Spindle Rotation to CW.
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Your settings (except possibly Home Position) shouldmatch the above image. Notice that, inMount-
ing Position, the vertical tool picture is oriented as you expect for the upper turret, left spindle.

3. ClickOK in the Lathe Tool Setup dialog box.

4. Select Draw Tool.

5. The dialog boxminimizes so that you can see the tool’s current state in the graphics window, as shown in the
following image.
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Note: As youmanipulate the tool’s setup, use Draw Tool often to check the results of your changes and to
ensure that the tool looks as you expect.

6. Press [Enter] to return to the dialog box.

7. ClickOK in the Define Tool and Tool Manager dialog boxes.

The tool is now ready to test.

8. Save the file as CustomTool03_xxx, where xxx is your initials.

Exercise 7: Testing the Tool in a Toolpath
1. Press [F9] to display the axes.

2. Right-click in the graphics window, and set the level to 1 by typing the level number into the box.

3. Use Line Endpoints to draw a line in the upper-left quadrant (minus X and plus Y position), setting its Length
to 200 and itsAngle to 0.
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Youwill use this line to create a simple Lathe Finish toolpath.

4. ClickOK in the function panel.

5. Press [F9] again to hide the axes.

6. Select Finish from the General gallery on the Lathe Turning contextual tab.

The Chaining dialog box displays.

7. Chain the line as shown in the following image, and clickOK.

The Lathe Finish dialog box displays.
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8. Ensure that your custom tool is selected, and clickOK.

Mastercam creates the toolpath.

9. Select the Toolpaths tab.

The ToolpathsManager displays.

10. In the ToolpathsManager, select the Lathe Finish toolpath.

11. Select Backplot selected operations.

The Backplot dialog box displays.

12. Press Play to backplot the toolpath to ensure that it works as expected.
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13. If you do not see the tool and holder, turn themon in the Backplot dialog box. These settings are off by
default.

14. Save the file as CustomTool04_xxx, where xxx is your initials.

Mastercam Lathe Custom Tools Tutorial—1: Creating a Vertically Oriented Tool
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GRAPHICAL ORIENTATION AND TOOL SETTINGS
In this lesson, you experiment with some of the tool settings to see how they relate to the tool’s location in the
graphics window. You will see that you can draw the tool wherever you like, but that the tool’s position affects the
settings youmust use, as well as the relative location of the toolpath.

Continue with the part file you completed in the previous lesson, or load the CustomTool04 file included with this
tutorial.

Exercise 1: Using Tool Orientation
In the previous exercise, you used Backplot to test the tool to ensure that it moved correctly across the geometry.
In this exercise, you change the orientation of the tool and then view it in Backplot.

1. In the ToolpathsManager, select Custom Tool.

The Define Tool dialog displays.

2. Change Tool Orientation In Turret to 2.

Note: Make sure that you change the Tool Orientation In Turret setting and not the Geometric Tool Ori-
entation In TOP Plane setting. Because the geometric orientation is based on how you drew the tool in the
graphics window, you do not need to change it once it is set.

3. Select Draw Tool, and notice how the tool orientation has changed tomatch the selected option.
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4. Press [Enter] to return to the dialog box, and clickOK.

The 1 or more operations use this tool dialog box displays.

5. Click Yes to accept that the changeswill update the operation.

Mastercammarks the toolpath as dirty.

6. Select Regenerate all dirty operations in the ToolpathsManager.

7. Select Backplot selected operations.

8. Press Play to backplot the operation, and notice how the tool is noworiented in the opposite direction.

9. ClickOK in the Backplot dialog box.
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10. Select the custom tool again in ToolpathsManager, and change Tool Orientation In Turret to 5.

11. ClickDraw Tool, and notice how the tool orientation has changed tomatch the selected option.

12. Press [Enter] to return to the dialog box, and clickOK.

The 1 or more operations use this tool dialog box opens.

13. Click Yes to accept that the changeswill update the operation.

14. Regenerate the operation.

15. Backplot the operation, and notice how the tool’s orientation has changed.

16. ClickOK in Backplot dialog box.
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17. Select the custom tool and change Tool Orientation In Turret back to 1, and clickOK.

18. Click Yes to accept that the changeswill update the operation.

Mastercammarks the toolpath as dirty.

19. Regenerate the operation, and backplot.

The operation is nowback to its original state, as shown below.

Exercise 2: Tool Position in the Graphics Window
1. Select Translate from the Transform tab.

The Translate function panel displays.

2. In the graphics window, select all of the tool geometry, and press [Enter].

34

Mastercam Lathe Custom Tools Tutorial—2: Graphical Orientation and Tool Settings



35

3. SetMethod toMove.

4. In the Delta settings, if you see Z, D, and Y, right-click in the graphics area, and choose Front, and then set
the orientation back to Top.

The Delta settings now showX, Y, and Z.

5. Set X and Y to 5.0, and clickOK.

6. Right-click in the graphics window and select Clear Colors to reset the tool’s color values.

7. Press [F9] to display the axes.

Mastercam Lathe Custom Tools Tutorial—2: Graphical Orientation and Tool Settings



8. Zoom in on the origin to see how the insert’s tip is noworiented.

9. Press [F9] again to hide the axes.

10. Backplot, and notice that the image of the tool is now above the toolpath.

This is because you have moved the tool’s centerpoint to X5.8, Y5.8, but Mastercam still thinks it’s at X0.8,
Y0.8.

11. Select Custom Tool in ToolpathsManager.

The Define Tool dialog box displays.

12. Click Tool Center to return to the graphics window.

36

Mastercam Lathe Custom Tools Tutorial—2: Graphical Orientation and Tool Settings



37

13. Select the center of the arc to reset the tool center to its new location.

14. The tool center should be set to X5.800 Z5.800 mm.

15. ClickOK in the Define Tool dialog, click Yes in the message that displays, and regenerate the toolpath.

16. Backplot the toolpath.

17. Notice that the tool is nowback in the correct position, but the toolpath has beenmoved down by 5 mm.

This is because the relative position of the tool to the toolpathed geometry has changed by 5 mm.

18. ClickOK in the Backplot dialog box.
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Exercise 3: Restore the Tool to its Original Settings
1. Select Translate on the Transform tab.

The Translate function panel displays.

2. Select all of the tool geometry, and press [Enter].

3. SetMethod toMove.

4. Set Z and X to -5.0, and clickOK.

5. Select the custom tool in the ToolpathsManager.

6. Select Tool Center.

7. Select the center of the arc shown below to reset the tool's centerpoint.
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The Tool Center should be reset back to X0.800 Z0.800 mm.

8. ClickOK in the Define Tool dialog box, and then click Yes in the message box that displays.

9. Select Clear Colors, regenerate the operation, and backplot.

The operation is nowback to its original state, as shown below.

Mastercam Lathe Custom Tools Tutorial—2: Graphical Orientation and Tool Settings
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CREATING A HORIZONTALLY ORIENTED TOOL
In this lesson, you create a horizontally oriented tool that will be used in the machine’s upper turret to cut material
on the right spindle. To do this, you complete the following procedures:

l Reposition the vertical tool you created in Chapter 1.

l Set the tool’s properties.

l Test the tool with a toolpath.

Exercise 1: Rotating the Tool
In this exercise, rather than draw a new tool from scratch, you reorient the vertical tool you created so that it lies
horizontally in the lower-left quadrant of the graphics window, as shown below. This puts the tool in the expected
position for a horizontal tool that will cut on the right spindle.

1. Open CustomTool02, either the one you created or the one included with this tutorial.

2. If necessary, press [F9] to display the axes in the graphics window.

3. Select Rotate from the Transform tab.

The Rotate function panel displays.

41



4. Select all of the tool geometry, and press [Enter].

5. SetMethod toMove.

6. Click the horizontal armof the rotation gnomon, and rotate the tool -90 degrees.
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7. ClickOK. The tool geometry is now in the position shown below.

8. ChooseMirror from the Transform tab.

TheMirror function panel displays.

9. Select all of the tool geometry, and press [Enter].

10. SetMethod toMove and select the Y offset.

Note: If you have Delta settings with Z, D, and Y, right-click in the graphics area, and choose Front, and then
set the orientation back to Top.
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11. ClickOK. The tool geometry should nowbe in the position shown below.

12. Right-click in the graphics window and select Clear Colors.

Mastercam restores the geometry to its original colors.

13. Zoom in on the origin, and notice how the insert’s tip is nowpositioned.

14. Press [Alt + F1] to fit the tool to the graphics window.

15. Save the file as CustomTool05_xxx, where xxx is your initials.

Exercise 2: Setting the Orientation and Position
After you draw the tool’s geometry, youmust set the tool parameters that tell Mastercamhow to interpret and use
the tool geometry. These settings are different for this horizontal tool than for the vertically oriented tool you cre-
ated earlier in the tutorial.

1. Select Lathe, Default from theMachine tab.

44
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Mastercam starts a newmachine group in ToolpathsManager.

2. Select Lathe Tool Manager from the Lathe Turning contextual tab.

The Tool Manager dialog box displays.

3. Right-click in the upper box, and choose Create tool.

The Define Tool dialog box opens.

4. Select the Custom tool type.

The dialog box automatically switches to the Geometry tab.

5. Ensure that for Geometric Tool Orientation In TOP Plane, orientation 7 is selected.

This is the orientation of the tool’s geometry as it is viewed in the Top plane. Note that choices 3 and 7 have
the same geometric orientation, but the cut and plunge directions are different.
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6. Ensure that for Tool Orientation In Turret, orientation 7 is selected.

This is the orientation of the tool as it will be mounted in the turret. Note that, again, choices 3 and 7 have the
same geometric orientation, but the cut and plunge directions are different.

7. In the Tool Geometry box, ensure that Level is selected and that the level shown is 111.

This is the level on which you drew the tool geometry.

8. Click Select next to Corner Radius (mm).

The dialog boxminimizes so that you can access the graphics window.

9. Zoom in on the insert’s tip, and select the tip’s arc. Youmay see arcs that display the previous selected Corner
Radius.

Mastercam returns you to the Define Tool dialog box.
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10. Select Tool Center.

The dialog boxminimizes so that you can access the graphics window.

11. Zoom in on the insert’s tip, and select the tip’s centerpoint. Youmay see arcs that display the previous selec-
ted Tool Center.

Mastercam returns you to the Define Tool dialog box, with X-0.800 Z-0.800 mm entered as the tool's cen-
ter.

Exercise 3: Setting Tool Type and Compensation
1. Click the Tool Type tab, and ensure that General Turning is selected.

2. Click the Parameters tab, and ensure that the first Compensation option is selected.
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This selection specifies that compensation for a toolpath is based on the sharp corner of the tip corner radius.

Exercise 4: Setting Up the Tool
1. Select Setup Tool.

The Lathe Tool Setup dialog box displays.

2. Select the following:

a. Mounting Position toHorizontal.

b. Turret to Top.

c. Default Active Spindle to Right.

d. Spindle Rotation to CCW.

Your settings, except possibly Home Position, shouldmatch the above image.

3. ClickOK in the Lathe Tool Setup dialog box.

4. Select Draw Tool.
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The dialog boxminimizes so that you can see the tool’s current state in the graphics window.

5. Press [Enter] to return to the dialog box.

6. ClickOK in the Define Tool and Tool Manager dialog boxes.

The tool is now ready to test.

7. Save the file as CustomTool06_xxx, where xxx is your initials.

Exercise 5: Testing the Tool in a Toolpath
1. Change the level number to 1.

2. Draw a horizontal line on the screen in the upper-right quadrant of the graphics window.

You will use this line to create a simple Lathe Finish toolpath.
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3. Select Finish from the General gallery on the Lathe Turning contextual tab.

The Chaining dialog box displays.

4. Chain the line as shown below, and clickOK.

The Lathe Finish dialog box opens.

5. Ensure that your custom tool is selected, and clickOK.

Mastercam creates the toolpath.

6. Backplot the toolpath to ensure that it works as expected.

7. Save the file as CustomTool07_xxx, where xxx is your initials.
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CONCLUSION
Congratulations! You have completed the Mastercam Lathe Custom Tools Tutorial! Now that you have mastered the
skills in this tutorial, explore Mastercam's other features and functions.

Youmay be interested in other tutorials that we offer. Mastercam tutorials are being constantly developed, and we
will addmore as we complete them. Visit our website, or select Help, Tutorials from the File tab.

Mastercam Resources
Enhance your Mastercamexperience by using the following resources:

l Mastercam Documentation—Mastercam installs a number of helpful documents for your version of software
in the Documentation folder of your Mastercam2019 installation.

l Mastercam Help—AccessMastercamHelp by selectingHelp, Contents fromMastercam's File tab or by press-
ing [Alt+H] on your keyboard.

l Mastercam Reseller—Your localMastercamReseller can help withmost questions about Mastercam.

l Technical Support—Our Technical Support department (+1 860-875-5006 or support@mastercam.com) is
openMonday through Friday from8:00 a.m. to 5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—We offer a series of tutorials to help registered users become familiar with basic
Mastercam features and functions. Visit our website, or select Help, Tutorials fromMastercam's File tab to
see the latest publications.

l Mastercam University—MastercamUniversity, an affordable online learning platform, gives you 24/7 access to
Mastercam trainingmaterials. Take advantage of more than 180 videos to master skills at your own pace and
help prepare for MastercamCertification. For more information onMastercamUniversity, please contact
your AuthorizedMastercamReseller, visit www.mastercamu.com, or email training@mastercam.com.

l Online Communities—You can find awealth of information at www.mastercam.com. For tech tips and the
latest Mastercamnews, follow us on Facebook (www.facebook.com/mastercam), Twitter
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam). Visit our YouTube channel to see
Mastercam in action (www.youtube.com/user/MastercamCadCam)! Registered users can search for inform-
ation or ask questions on the MastercamWeb forum, forum.mastercam.com, or use the knowledgebase at
kb.mastercam.com.

Contact Us

For questions about this or other Mastercamdocumentation, contact the Technical Documentation department by
email at techdocs@mastercam.com.

Mastercam Lathe Custom Tools Tutorial—Conclusion
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